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BIOSYSTEMS GAS DETECTORS HAVE BEEN DESIGNED FOR THE 
DETECTION OF DEFICIENCIES OF OXYGEN, ACCUMULATIONS OF 
FLAMMABLE GASES AND VAPORS AND ACCUMULATIONS OF 
TOXIC VAPORS. 

 
IN ORDER TO ASSURE THAT THE USER IS PROPERLY 
WARNED OF POTENTIALLY DANGEROUS 
ATMOSPHERIC CONDITIONS, IT IS ESSENTIAL THAT 
THE INSTRUCTIONS IN THE REFERENCE MANUAL FOR 
THE SPECIFIC GAS DETECTOR BE READ, FULLY 
UNDERSTOOD, AND FOLLOWED. 

 
 
 

AVERTISSEMENT:  LIRE ATTENTIVEMENT LES INSTRUCTIONS AVANT 
DE METTRE EN MARCHE. 

 
 
 
 
 
 
 
 

BioTrak Reference Manual 
Version 2.60 

Copyright 2006 
by 

Biosystems 
Middletown, Connecticut 06457 

 
All rights reserved. 

No page or part of this operation manual may be reproduced in any form  
without written permission of the copyright owner shown above. 

All rights reserved to correct typographical errors. 
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Introduction 
Biosystems Datalink Kits consist of a copy of Biosystems' BioTrak Software for the 
Biosystems Family of Gas Detectors and a software instruction manual. 

A computer interface cable is also included for connection of the PhD5 and PhD Ultra to a 
serial port on the user's IBM compatible computer.  The Toxi Ultra serial cable is built into its 
data dock.  The PhD Lite, Cannonball3 and MultiVision interfaces require an infrared 
transceiver.  This transceiver can be purchased from Biosystems or a third party vendor.  
Most of portable computers manufactured today have an infrared transceiver.  BioTrak is 
capable of running in Windows 95, 98, 2000, XP and NT. 

BioTrak is menu driven for easy use.  The software allows your Biosystems gas detector 
and your computer to communicate.  It serves two basic functions: retrieving stored 
information from the gas detector and using the computer to "configure" the gas detector. 

Optional instrument setups are created by "filling out" configuration forms displayed by the 
software.  Most functions (such as downloading stored information from the instrument to 
your PC) are automatic or as easy as pushing a button.  The software is designed to help 
you along. 

Once the session information has been "downloaded" to the computer, it may be used for a 
variety of purposes.  Data may be displayed and reviewed in detail through the Session 
Summary form, or used to automatically generate reports, tables, and time history graphs. 

It is also possible to export data session records to formatted text for import into other 
software applications.  Another option is to simply retain downloaded records as computer 
files to provide a permanent record of your gas detection-monitoring program. 

The best way to learn the software is to use it! 
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1. Installing BioTrak 
Download Software 

1.1 PC Requirements 
The minimum PC requirements for 
BioTrak are as follows: 

•Pentium Processor 366mHz or better or 
equivalent. 
•32MB RAM. 
•Windows 95/98/2000/NT4.0 (w/Service 
Pack 5 or higher)/XP 
•30MB hard drive disk space. 
Note:  Windows XP or Windows 2000 
with Service Pack 3 is required for 
instruments that communicate via 
infrared (Cannonball3, MultiPro, 
MultiVision, PhD Lite, ToxiPro/Ltd and 
ToxiVision EX). 

1.2 Installing BioTrak on 
Windows™ 95, 98, 2000, XP or NT 
To install BioTrak software to a PC using 
Windows™ 95, 98, 2000, XP or NT: 

1. Insert the BioTrak CD into the PC’s 
CD drive.  If the installation does not 
start automatically, click on your CD 
drive in Windows Explorer.   There 
are subfolders for the English and 
French installations.  Click on the 
appropriate folder and then click on 
the “Setup.exe” file to begin the 
installation. 

 

↓ 

 
2. Click “Next” at the Welcome screen.  

The License Agreement screen will 
be shown. 

 
3. Read the License Agreement.  If you 

agree to the terms set forth in the 
agreement, click “I accept the terms 
in the license agreement” followed by 
“Next”.  Failure to accept the terms of 
the license agreement will cause the 
installation to terminate.  The 
Installation Requirements will then be 
shown. 

 
4. Click “Next”.  The Customer 

Information screen will then be 
shown.   
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5. Fill in the User Name and 

Organization and decide whether the 
BioTrak program should be available 
to all users or only you.  Then click 
“Next”. The destination folder screen 
will then be shown. 

 
6. Click “Next” to install BioTrak into the 

default location at the “C:\ Program 
Files \ BIOSYSTEMS \ BioTrak” 
folder.  If you wish to store the 
database in a different directory use 
the “Change” button and select a 
different destination.  Then click 
“Next”.  The Setup Type screen will 
be shown. 

 
7. Biosystems recommends selecting 

the “Typical” installation.  Individuals 
with more experience with the 
BioTrak program may choose the 
Custom or Minimal installation.  Once 
the selection is made, click “Next” 

 
8. Click “Install”. 

 

↓ 

 
9. Click “Finish”.  BioTrak has now been 

installed. 

2. Using BioTrak Datalink 
Software 

BioTrak Datalink Software allows a PC to 
communicate with a datalogger-equipped 
Biosystems gas detector.  The 
connection between the PC and the gas 
detector is either by datadock and serial 
interface cable (PhD5, PhD Ultra and 
Toxi/Oxy Ultra) or by Infrared port 
(Cannonball3, MultiPro, MultiVision, PhD 
Lite, ToxiPro/Ltd, ToxiVision EX). 

2.1 Serial Port Connection 
Instruments that connect to the PC 
through a datadock via serial interface 
cable include the PhD5, PhD Ultra and 
Toxi/Oxy Ultra.  The serial interface cable 
should be connected from a powered 
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datadock to the PC’s parallel port.  
BioTrak’s Auto-Detect function 
recognizes an instrument in the datadock 
once the software is launched. 

2.2 Infrared Port Connection 
Instruments that connect to the PC via 
Infrared (IrDA) port include the 
Cannonball3, MultiPro, MultiVision*, PhD 
Lite, ToxiPro/Ltd and ToxiVision EX. 

Many new PC’s include an IrDA port as 
standard equipment.  If your PC does not 
include an IrDA port, an outboard 
Infrared transceiver can be purchased 
from Biosystems or a third party vendor 
to create an infrared port. 

Note:  If you must purchase an IrDA 
transceiver, Biosystems recommends 
the JetEye PC IrDA Serial Adapter by 
Extended Systems (model number 
ESI-09680-7401), which can be 
purchased directly through Extended 
Systems or through Biosystems. 
Note that the MultiVision must have a 
fully enabled datalogger to be able to 
communicate with the PC via IrDA.   

2.2.1 Infrared Port Activation 
BioTrak will activate the IrDA port 
automatically when an instrument that 
requires an IrDA interface is selected 
from the Instruments menu.  The 
following icon(s) will be displayed on the 
WindowsTM taskbar in the lower right 
corner of the screen.  A single IrDA icon 
indicates that the IrDA port is functioning 
but is currently not reading anything. 

 
To establish the Infrared link with the 
instrument, the detector must be placed 
in communications mode as described in 
its operating or reference manual.  Once 
the instrument is in communications 
mode, place it in front of the computer’s 
infrared port.  Once the instrument’s IrDA 
signature is recognized by the PC, the 
following will appear on WindowsTM 
taskbar (the icon on the right represents 
the instrument): 

 

The two icons will flash to indicate that 
data is being transferred. 

2.3 Main Menu Options 
The BioTrak software’s Main menu lists 
four items:  File, Instrument, Computer, 
and Help. 

 
The File menu is used to open previously 
saved session data files, to set program 
options and to exit the program. 

 
The Instruments menu is used to detect 
supported Biosystems gas detectors that 
are recognized by the PC, automatically 
download instrument data, and to directly 
select an instrument type. 

 
To perform tasks such as instrument 
configuration, downloading session data, 
clearing the datalogger memory, and 
setting the instrument's internal clock, 
you must first establish communication 
with the instrument using the 
Instruments menu. 

The Computer menu allows detection 
and selection of the default 
communication port(s) used when the 
instrument type is selected using the 
instrument menu or Auto Detect or Auto 
Download functions are used.   
Note: The first time BioTrak is 
executed the Com/Infrared ports will 
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be detected automatically.  The 
default port will be the first available 
port. 
Menu options are covered at length in 
the subsequent chapters of this manual. 

3. File Menu 
3.1 General 
The "File" menu is used to open existing 
datalogger files, to set BioTrak's general 
program options, and to exit the program. 

3.2 File / Open 
The “Open” item from the File Menu is 
used to open existing session data files.  

 
BioTrak will automatically open to the C:/ 
Program Files / BIOSYSTEMS / BioTrak 
/ Db Folder unless another location was 
chosen during software installation. 

 
The Open Dialog box will default to list 
all available datalogger files in the 
current directory.  The File Dialog box 
allows you to change directories to look 
for files in other locations. 

The "Files of type" drop down list allows 
the display to customize the display from 
all available datalogger files to files only 
from a certain instrument.  

Click on a file name in the list and select 
"Open" to load the file into the program.  
The file selected here will be the file to 
which new data is saved following 
instrument download. 

3.3 File / Options 
The “Options” item is used to configure 
the BioTrak program for user 

preferences.  The Options screen 
includes 8 tabbed pages with controls for 
everything from language selection to 
printing preferences.  These options are 
discussed in detail below in sections 
3.3.1 through 3.3.8 of this manual. 

 
↓ 

 
3.3.1 Detection Options 
The "Detection" tab allows the user to 
define search parameters for the "Auto 
Detection" and "Auto Download" 
functions (as discussed in section 4.1 
and 4.2).  Instruments that connect to the 
PC via serial interface cable and 
datadock can be automatically detected 
by the PC.  These instruments include 
the PhD5, PhD Ultra and Toxi/Oxy Ultra 
(see section 4.3). 
Note:  Instruments using an IrDA 
connection with the PC (Cannonball3, 
MultiPro, MultiVision, PhD Lite, 
ToxiPro/Ltd and ToxiVision EX) 
cannot be "Auto Detected". 

 
3.3.2 Printing Options 
The "Printing" tab controls BioTrak 
printing options.  The "Session 
Summary Printing" options allows the 
user to select between printing all the 
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sessions in the database or just the 
current session. 

Select "Show Print Preview" to preview 
a report before it is printed.  The preview 
may then be printed or cancelled. 

 
3.3.3 Data Export Options 
The "Data Export" tab allows the user to 
select the format of the text file created 
when the session data is exported from 
the data table.  The new text file can 
easily be imported into spreadsheet or 
database applications.  The files can be 
exported as “Tab Delimited” or as 
“Comma Delimited” files. 

 
3.3.4 Toxi/Oxy Ultra Options 
The "Toxi Ultra" tab enables you to set 
the time on the Toxi Ultra when the 
configuration is uploaded.  Note: The 
time will always be reset to computer 
time during a session download.  

 
3.3.5 Language Options 
The "Language" tab allows the user to 
select the default language for the 
BioTrak program.  As of the publication 
of this manual, English and French were 
the two available languages.  After a new 

language has been selected, "click" the 
"OK" button and the program including 
its Help file will instantly change to the 
chosen language. 

 
3.3.6 Auto Download Options 
The "Auto Download" tab controls the 
options for the Auto Download feature. 

The Download Time setting allows the 
user to set the time for the automatic 
downloads to begin (typically used to 
automate the downloading of data files 
while the instrument is charging 
overnight in its datadock, which must be 
connected to the PC by serial cable)  To 
adjust the time setting, use the controls 
to the right of the time.   

The "10 Letter Prefix" allows the user to 
enter a prefix for the datalogger file 
created during the download.  The prefix 
should uniquely identify the instrument or 
location for future reference.  The rest of 
the filename will consist of date and 
appropriate extension for the 
downloaded instrument (see Auto 
Download function in section 4.3 for 
further information).   

Note:  Instruments that connect via 
IrDA interface (Cannonball3, MultiPro, 
MultiVision, PhD Lite, ToxiPro/Ltd, 
ToxiVision EX) are not supported in 
the "Auto Download”. 

 
3.3.7 Infrared 
The "Infrared” tab has a checkbox that 
controls whether the infrared monitor is 
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launched automatically during 
connection.   

 
3.3.8 ToxiPro/Ltd 
The "ToxiPro/Ltd” tab controls the 
number of records that will be 
downloaded automatically when the 
ToxiPro or ToxiLtd is connected to the 
PC (via IrDA).   

 
3.4 File / Exit 
Use the “Exit” from the File Menu to exit 
the BioTrak Datalink software. 

4. Software use / 
Instruments Menu 

For instructions on connecting 
instruments that connect via datadock 
including the PhD5, PhD Ultra and Toxi 
Ultra, proceed to section 4.1.  
Autodownload instructions are contained 
in section 4.2.  

For instructions on connecting 
instruments that connect via IrDA port 
including the Cannonball3, MultiPro, 
MultiVision, PhD Lite, ToxiPro/Ltd and 
ToxiVision EX, proceed to section 4.3. 

Once the connection is established, 
sections 4.4 though 4.7 cover available 
options.  

4.1 Connecting the PhD5, PhD 
Ultra, Toxi/Oxy Ultra to the PC 
To automatically detect a PhD5, PhD 
Ultra or Toxi/Oxy Ultra, turn the 
instrument off and place it in its 
datadock, which should be connected to 

the PC via serial interface cable.  Then 
select Auto Detect option from the 
Instrument menu. 

 
The Auto Detect feature will 
automatically detect any supported 
instruments that are connected to the PC 
via datadock and serial interface cable, 
including the PhD 5, PhD Ultra and 
Toxi/Oxy Ultra. 

Instruments that connect to the 
computer via IrDA port (Cannonball3, 
MultiPro, MultiVision, PhD Lite, 
ToxiPro/Ltd, ToxiVision EX) cannot be 
auto-detected. 
Once Auto Detect is selected, BioTrak 
will search for any Biosystems 
instruments connected to the computer 
via serial cable and datadock. 

 
After the PC detects the instrument, a list 
of available instruments will be displayed 
in the "Available Instrument List".  If 
more than one instrument is currently 
connected to the PC, the first instrument 
detected becomes the default for your 
next selected function (downloading 
session data, configuration, etc.).  To 
change the selected instrument, 'click' on 
the desired instrument in the list. 
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Proceed to section 4.3 – 47 for detailed 
instruction on the available options once 
the instrument is recognized. 

If BioTrak fails to detect any instruments, 
it will notify you that no instruments have 
been found. 

 
4.2 Auto Download (for PhD5, 
PhD Ultra and Toxi Ultra) 
The Auto Download function allows the 
user to automatically detect, download, 
and save the results to a file in a single 
step. 

The Auto Download feature will 
automatically detect any supported 
instruments that are connected to the PC 
via datadock and serial interface cable, 
including the PhD 5, Phd Ultra and 
Toxi/Oxy Ultra.   

Instruments that connect to the 
computer via IrDA port (Cannonball3, 
MultiPro, MultiVision, PhD Lite, 
ToxiPro/Ltd, ToxiVision EX) can not 
be auto-downloaded. 
To use the Auto Download function, 
follow these steps: 

1. Verify that all the instruments are 
turned off and in their respective data 
dock. 

2. Check the Auto Detection tab on 
"Options" form to verify the correct 
instruments are selected for the 

detection.   
3. Select "Auto Download" from the 

Instrument menu. 

 
Next a form showing the time the “Auto 
Download” will begin and the current 
time will be displayed.  The user can 
select the “Cancel” at anytime to cancel 
the Auto Download sequence. 

 
During the Auto Download, the software 
will perform the following functions: 

Auto Detection – Determines the 
attached instruments available for 
download. 

Downloads – Downloads each 
instrument detected in the previous step. 

Save Results – Saves each download to 
the proper file format. The new file 
names will be uniquely generated to 
consist of the 10 letter Prefix that was 
entered in section 3.3.6, along with the 
current date and file type.  For example: 

• 10 Letter Prefix:  Manhole12 

• Date:  11/05/1999 

• Instrument:  PhD5 

• Result:  
Manhole12_11_05_1999.ph5 

Once the auto download is completed, 
the user may view the results of the 
download. 



12 

4.3 Connecting the 
Cannonball3, MultiPro, MultiVision, 
PhD Lite, ToxiPro/Ltd and 
ToxiVision EX  
Instruments that connect via IrDA must 
be selected in the instrument menu to 
begin the detection process. 

Instruments that connect via datadock 
(Cannonball3, PhD Ultra, PhD5, Toxi 
Ultra) may also be detected by selecting 
the instrument type in the Instrument 
menu.  Since the instruments that 
connect via datadock are covered in 
section 4.1, this section will only cover 
instruments that connect via IrDA. 

1. Select the appropriate instrument. 

 
Once the instrument is selected, the PC 
will automatically enable the PC’s IrDA 
port and begin the connection process.   

A red light in the status display bar at the 
bottom of the window indicates that no 
connection has been recognized. 

 
The connection will be initiated by the 
BioTrak program once an operation is 
selected from the option bar. 

 

2. Select the appropriate operation.  
The PC will direct you to align the 
IrDA port on the instrument with the 
PC’s IrDA port. 

 
3. Follow the instructions given on 
the screen.   

If you are unsure of the location of the 
detector’s IrDA port, see the detector’s 
operating manual. 

A green light in the status display bar 
indicates that an instrument has been 
detected.   

 
BioTrak will then proceed with the 
operation specified above.  Detailed 
instructions for the available operations 
are covered in sections 4.3-4.7 below 

4.4 Download 
Note:  This section assumes that you 
have initiated the connection between 
the PC and the instrument as 
described above in section 4.1 for the 
PhD5, PhD Ultra and Toxi/Oxy Ultra or 
as described above in section 4.3 for 
the Cannonball3, MultiPro, 
MultiVision, PhD Lite, ToxiPro/Ltd and 
ToxiVision EX. 
To download the datalogger in the 
instrument, click on Download in the 
options bar near the bottom of the 
window.  BioTrak will proceed to 
establish contact with the instrument and 
to download the datalogger.  A status bar 
located just above the options bar will 
show the progress of the download. 
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Once the download is complete, a 
session summary will be shown. 

Note:  The complexity of the Session 
Summary screen will vary with the 
instrument type and specific session 
information. 

 
4.4.1 Session Summary File Menu 
The File Menu in the Session Summary 
contains a number of options.  General 
controls are located in the File Menu at 
the top of the screen.  Specific data 
controls are located in the option bar 
near the bottom of the screen. 

4.4.1.1 File / Save the Data File 
When data transfer is complete select 
“Save As…” from the File Menu to save 
the Instrument Summary Information 
form to the hard disk. 

 
A Save As Dialog box will be shown. 

 
A default file name will appear that 
comprises the instrument type, serial 
number, date and time.  The default file 
name is designed to be unique and easy 
to locate in the future.  To use the default 
file name click on the 'Save' button to 
save the file.  Otherwise, enter a new file 
name and click the 'Save' button to save 
the file. 

4.4.1.2 File / Options 
See section 3.3 above for detailed 
descriptions of the available options in 
the File menu. 

4.4.1.3 File / Graph options 
The Graph option in the File Menu 
contains controls for the graph’s 
appearance including “Graph Data”, 
“Scaling”, “Grid”, “Thickness” and “Color”.  

 
The "Graph Data" tab allows the user to 
select the data to be displayed when the 
“Graph” option is selected from the lower 
control bar (see section 4.4.2.3).   Each 
sensor has specific data that can be 
“toggled" on and off as needed by the 
user.   The only exception is 
temperature; the user must select either 
Fahrenheit or Celsius. 
Note:  Only one graph type selection 
can be made at a time.  Do not select 
more than one type of graph per 
sensor (e.g. for the O2 sensor, do not 
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select the Battery Voltage and Max 
Data at the same time). 

 
The "Scaling" tab allows the user to 
scale the graphs to the "Highest Point", 
the "Alarm Setting" or "User-defined".  If  
"User-defined" is selected, the user can 
set the Max and Min values for the scale 
and the number of ticks between the Max 
and Min. 

 
The "Grid" tab defines how the grid on 
the graph will be displayed.  Display Grid 
must be selected first to enable the Grid 
Style, Grid Line Style and Tick Style 
options, each of which have several 
settings. 

 
The "Thickness" tab allows you to 
define the width of the lines used in the 
graph. 

The 
"Color" tab defines the graph to be in 
Color or Monochrome. If Monochrome 
color is selected, the graph legend will 

have symbols instead of colored slashes. 

 
4.4.2 Lower Control Bar 
The control bar at the bottom right of the 
Window includes database controls 
"Next" and "Previous" for scrolling 
through the record set.  It also includes 
controls for Alarms”, “Graphs”, “Print”, 
and “Table”. 

 
The “Details” button only appears when 
there has been an alarm condition during 
the session. 

4.4.2.1 Details Button 
If the instrument went into alarm during 
the session, the “Details” button will be 
shown to the left of the “Alarms” and 
“Print” buttons.  Press the detail button to 
view the details of the session. 
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In the example below, the low battery 
alarm was triggered.  Press OK to return 
to the session summary. 

4.4.2.2 Alarms 
Press the “Alarms” button will to view the 
alarm settings for the sensors installed 
during datalogging of the current session.   

 
4.4.2.3 Graphs 
One the most powerful ways of reviewing 
session data is to examine the data in 
the form of a time-history graph.  Plotting 
gas-reading values registered during the 
monitoring session against time 
generates time-history graphs.   

Use the "Graphs" button to display time 
history session graphs.  A graph will be 
created for each sensor(s) installed in the 
instrument during the session. 

 
Each time history graph(s) is identified by 
sensor type.  Each sensor type has 
distinct options based on the types of 
alarms that the sensor offers.  Graph 
type options are discussed in section 
4.4.1.3.   

Note: To add a comment to the 
graphs, simply move the mouse over 
the graphs and double-click.  A text 
box will appear where the comment 
can be added.  A comment is limited 
to 80 characters in length. 
If the following error message is shown, 
return to the File / Graph Options menu 
item and deselect one of the graph types.  
Then click the Graphs button again.   

 
Graph Menu Options 
When a graph is being displayed, the 
Graph Menu option will appear at the top 
of the graph.  

Each graph shows readings registered 
throughout the entire monitoring session 
compressed to fit into the available 
monitor screen space.  

It is possible to enlarge a graph to the full 
size of the screen by using the “Full Size” 
item in the Graph menu and selecting 
the desired graph.  
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A graph can also be viewed in greater 
detail by selecting the "Zoom" item from 
the Graph menu and following these 
steps: 

 
1. Move the mouse to the area of the 

graph to "zoom" 

2. 'Click' and hold the left button to 
create a "zoom box" 

3. Move the mouse until the "zoom box" 
surrounds the desired area (see 
below). 

 
4. After the mouse button is released, 

the graph will expand to the  
"zoomed" area.  A graph can be 
zoomed in normal and full size views. 

 
Press “Restore” from the File menu and 
then select the sensor to return the 
selected graph back to its original size. 

4.4.2.4 Data Table Button 
Choose the “Table” button from the 
Session Summary Information form to 
view data in the form of a spreadsheet.  
Each line of the table represents values 
registered during a specific datalogging 
interval.  The parameters displayed in 
each line are run time, time of day, 
oxygen concentration (if applicable), LEL 
concentration (if applicable) and readings 
for up to two toxic sensors.  Besides 
showing the peak toxic concentration 
readings for each datalogging interval, a 
STEL and TWA value are also logged 
(when applicable) for each sensor.  Each 
line also includes the battery voltage and 
instrument temperature for that data 
point.  

 
The program will load the first 200 
available session data points into the 
data table.   

Use the “Top” button to move to the top 
of the list and the “Bottom” button to 
move to end of the list.  If the data 
session is greater than 200 points, use 
the “Next 200>>” button to move down 
the list 200 points and “<<200 Prev” to 
move up the list 200 points.  The total 
number of session data points is 
displayed in the lower right corner of the 
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data grid.  Note the column size can be 
adjusted by moving the cursor into 
the column header and clicking and 
dragging the to the left or right of the 
header. 
The “Print” button may be used to send 
the contents of the current form of 
information being viewed directly to a 
printer.  

Select “File Export ” button to export the 
data to an ASCII comma delimited file 
format for use in a spreadsheet program.  
The format of the data for output is 
determined in the “Options” menu item 
found under the menu bar item “File” 
(see section 3.3). 

4.4.2.5 Viewing Alarm Legend 
If an alarm condition has occurred in the 
PhD5, PhD Lite, MultiVision or 
Cannonball3, it will register in the data 
table as a symbol.  Explanation of each 
symbol can be found by using the Alarm 
Legend.  Using the "File" menu and 
selecting the "Alarm Legend" item 
accesses the legend. 

 
↓ 

 
4.5 Configuration 
Note:  This section assumes that 
connection has been initiated between 
the PC and the instrument as 
described above in section 4.1 for the 
PhD5, PhD Ultra and Toxi Ultra or as 
described above in section 4.3 for the 
Cannonball3, MultiPro, MultiVision, 
PhD Lite, ToxiPro/Ltd and ToxiVision 
EX. 

Instrument configuration allows to the 
user to adjust the instrument's internal 
operating parameters to personal 
preferences. 

Connect the PC to the instrument as 
described above.  For PhD5, PhD Ultra 
and Toxi Ultra, follow the instructions 
given in section 4.1.   

For Cannonball3, MultiPro, MultiVision, 
PhD Lite, ToxiPro/Ltd and ToxiVision EX, 
follow the instructions given in section 
4.3. 

After the download is complete, the 
“Configuration Settings” window will be 
shown with the Alarm Settings tab 
activated. 
Note:  If the configuration settings are 
edited, the status box on the bottom 
of the form will change from 
"Configuration from Instrument" to 
"Configuration modified by User" and 
any changes will be displayed in red. 
Note:  The number and type of 
configuration screens vary with 
instrument type.  The following 
section is intended as a sample of the 
configuration screens.  The 
configuration screens shown on your 
PC may be slightly different. 

4.5.1 Configuration / Alarm Tab 
The "Alarms" tab on the Configuration 
Settings form allows the user to adjust 
alarm settings for all sensors installed in 
the unit.  Alarms vary by instrument type, 
but typically include high and low alarms 
for oxygen sensors, ceiling alarm for LEL 
sensors and some combination of 
danger, warning, ceiling, STEL and TWA 
alarms for each toxic sensor installed into 
the unit. 

 
Biosystems default gas detection alarms 
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are set very conservatively to minimize 
the risk of injury. Factory default alarm 
settings may be restored at any time by 
pressing the "Restore Alarm Defaults" 
button. 

Note:  The MultiPro’s Alarms Tab 
contains the CF Value for the CO/H2S 
sensor.  If the MultiPro is equipped a 
CO/H2S sensor that is part number 54-
49-24, the CF Value shown in the 
configuration screen must match the 
value shown on the sensor.  To 
change the value, enter it in the input 
box below CF Value and press the 
“Upload” button.  If the MultiPro is 
equipped with a CO/H2S sensor that is 
part number 54-49-14, then the CF 
Value shown in the configuration 
screen must equal “0”. 

4.5.2 Configuration / Datalogger 
Tab 
The "Datalogger" tab on the 
Configuration Settings form allows the 
user to adjust the datalogger interval, 
and to set the instrument date and time. 
The instrument's firmware version and 
OTP versions are shown if available.   

Use the "Set to Computer Date/Time" 
button to set the instrument's date and 

time to the current date/time on the 
computer. 

 
4.5.3 Configuration / Features Tab 
The "Features" tab on the Configuration 
Settings form is used to change settings 
for the Current Operating Mode, Alarm 
Latch, OK Mode Alarm Latch, Security 
Beep, and Decimal Point Display for 
each Toxic sensor.  For more information 
on the operation and setting for the 
above instrument features, please 
consult the instrument's operation 
manual. 

 
4.5.4 Configuration / Auto 
Calibration Tab 
The "Auto Calibration" tab on the 
Configuration Settings form is used to 
alter the concentration values for 
calibration gas used in the automatic 
calibration sequence.  Each installed 
sensor is listed with the expected gas 
concentration.  Using the spin buttons 
located to the right of each box changes 
the calibration gas value. 

Once these new settings are uploaded to 
the instrument, calibration gas at a level 
that corresponds to the new setting must 
be used in the calibration of the gas 
detector.   

  Calibration values 
shown in the calibration value table 
must match those appearing on the 
calibration gas cylinder(s) that will be 
used to calibrate the instrument.  Non-
matching calibration gas and 
calibration gas value settings will lead 
to inaccurate and potentially 
dangerous readings. 

 
If one of the sensors is a “CO Plus” 
sensor you will have the additional 
choice of indicating whether the sensor is 
to be calibrated to carbon monoxide or 
hydrogen sulfide.  An option box is 
provided to indicate your choice.  Please 
note that if a change is made to the type 
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of gas used to calibrate your CO Plus 
sensor, the alarm settings will 
automatically be altered to reflect the 
new hazard. 

You can also change the reading of the 
combustible sensor from LEL to CH4.  
Doing this allows you to view 
combustible gas in percent by volume for 
an area versus viewing the percent of the 
lower explosive limit.   

Note:  Older instruments may not offer 
this option, but it may be available if 
instrument software is updated.  Call 
Biosystems for details. 
Instruments equipped with the non-
specific chlorine sensor will have the 
option to change the readout between 
chlorine (Cl2) and chlorine dioxide (ClO2).  
See your instruments owner’s manual for 
a detailed explanation of this feature.  

Note:  Once this change is made and 
saved all chlorine sensor readings will 
register as ClO2 until it is changed 
back to Cl2.  
The “Defaults” button will reset the 
Calibration Gas Concentration values to 
the factory defaults for each installed 
sensor. 

4.5.5 Configuration / Calibration 
History Tab 
The “Calibration History” tab on the 
Configuration Settings form will display 
the last 8 fresh air and span calibration 
dates for each sensor. 

A 'double-click' on any of the calibration 
dates will display the exact time of the 
calibration. 

 
4.5.6 Configuration / 
User/Locations Tab 
After selecting the "User/ Locations" 

tab on the Configuration Settings form, a 
list for current User ID and Locations 
stored in the instrument will be shown.  
The user can modify each list by 
selection the "Edit” or "New" buttons.  
The "Edit” button will edit the current 
selected item in the list.  The "New" 
button will create a new entry in the list in 
the next available position in the list.  
Note: If the User or Locations lists are 
full the "New" button will be disabled. 
Once these lists are uploaded into the 
instrument memory, they can be selected 
and used to "tag" a monitoring session 
with user and location information at any 
time while the instrument is being used in 
the field.   

Note: In the PhD Ultra, the selected 
User and Location will be used the 
next time the PhD Ultra is logging a 
session.  In the Cannonball3, PhD5 
and PhD Lite, the current User ID and 
Location must be set in the 
instrument each time the instrument 
is turned on. 

4.5.7 Configuration Controls 
When you have finished editing the 
instrument's configuration, press the 
"Upload" button to upload the new 
configuration. 

 
During the upload, a progress bar will 
display the percentage of upload and the 
Status Line will display the current action. 

 
Note:  For instruments that connect 
by IrDA, the connection may need to 
be reestablished prior to upload.  If 
this is the case, a message will be 
shown on the PC screen with further 
directions.   
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After the upload is completed, BioTrak 
will return to 'Available Instruments' form. 
To cancel changes made to the 
configuration, press the "Cancel" button.  
The software will return to 'Available 
Instruments' form and put the instrument 
into 'Sleep Mode'. 

To print the instrument configuration 
settings, use the "Print" option button. A 
printer dialog box will appear: 

4.6 Clear Datalogger Memory 
Note:  This section assumes that you 
have initiated the connection between 
the PC and the instrument as 
described above in section 4.1 for the 
PhD5, PhD Ultra and Toxi Ultra or as 
described above in section 4.2 for the 
Cannonball3, MultiPro, MultiVision, 
PhD Lite, ToxiPro/Ltd and ToxiVision 
EX. 
1. Click on the "Clear Datalogger" 

button.  Follow the instructions given 
on the screen for completing the 
connection between the instrument 
and the PC. 

2. Once the connection is established, 
the following box will appear to verify 
that you want to clear the datalogger 
memory. 

 
If you select "No" then you will be 
returned to the 'Search Results' form.  If 
you select "Yes", then all recorded 
session data currently in instrument 
memory will be cleared. 

Make sure that any session information, 
which will be needed, is safely 
downloaded and stored prior to clearing 
the instrument memory.   

CAUTION: Once session data is 
cleared, it is permanently lost and 
may not be retrieved from the 
instrument in the future! 
Note:  This procedure only clears data 
recorded during monitoring sessions.  
The Configuration settings, such as 

Alarm Settings are not affected by this 
procedure. 

4.7 Setting Instrument Date and 
Time 
Note:  This section assumes that you 
have initiated the connection between 
the PC and the instrument as 
described above in section 4.1 for the 
PhD5, PhD Ultra and Toxi Ultra or as 
described above in section 4.2 for the 
Cannonball3, MultiPro, MultiVision, 
PhD Lite, ToxiPro/Ltd and ToxiVision 
EX. 
Select the "Set Time" button. The 
instrument's Date and Time will be 
synchronized to the PC clock.  After the 
process is finished, a message box will 
display the time that has been sent to the 
instrument. 

5. Computer and Help 
Menus 

5.1 Computer Menu 
Select the "Communication Setup" 
item from the Computer menu item to 
display the available serial 
communications port (COM 1-8) and the 
communications rate for the PhD Ultra 
that will be used during data transfer.  

 
The PC Setup screen will be shown. 

 
Use the "Auto Detect Ports" button to 
redetect the communication ports. 

The Baud Rate selections are only 
relevant for the PhD Ultra.  The PhD 
Ultra communicates using the "Standard" 
or "Turbo" communication rate.  The 
other instruments use the "Turbo" rate.   
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Note: This selection is only necessary 
if the PhD Ultra is being 
Download/Configured was not 
detected using the "Auto Detection" 
feature.  The "Auto Detection" 
function will automatically determine 
the rate. 

5.2 Help Menu 
The Help Menu is designed to provide 
“on-line” assistance to the user during 
operation of the BioTrak Download 
Software. 

While using the “on-line” help, the user 
can search for a topic by entering a key 
word.  Each topic can be sent to the 
printer for a hard copy and the help can 
be navigated by using several command 
buttons to move forward and backward 
through the list of topics. 

5.2.1 BioTrak Help File 
To access the BioTrak Help File, select 
Help followed by BioTrak Help.   

 
The Help File will then be shown. 

 
Controls are more or less self-
explanatory and are located near the top 
of the screen.  The Help Topics list can 
be accessed by clicking on the “Help 
Topics” button just below “File” near the 
top of the window.   

5.2.2 Help Contents and Index 

To access the Contents and Index File, 
select Help followed by BioTrak Help.   

 
Use the "Contents and Index" menu 
item to enter a keyword or subject name 
to find.  The list will automatically search 
for a match to the text that you enter.  
Once the subject or keyword is found, 
"double-click" the item and the help file 
will move to the selected topic. 

 
5.2.3 Internet Support 
The Internet support option contains 
automatic links to the Biosystems and 
Bacou-Dalloz websites.   

Biosystems’ web address is: 

http://www.biosystems.com 

5.2.4 About BioTrak 
Select the “About BioTrak” item from the 
Help menu. The “Program” tab displays 
the Software Version, Software Date, 
and Biosystems’ Technical Support 
phone number, and web site address.  
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The “System” tab displays information 
about the current installed version of 

Windows and the installation of any 
infrared devices. 

 



23 

Biosystems Standard Warranty Gas Detection Products 
General 
Biosystems, LLC (hereafter Biosystems) warrants gas detectors, sensors and accessories manufactured 
and sold by Biosystems, to be free from defects in materials and workmanship for the periods listed in 
the tables below.  
Damages to any Biosystems products that result from abuse, alteration, power fluctuations including 
surges and lightning strikes, incorrect voltage settings, incorrect batteries, or repair procedures not made 
in accordance with the Instrument’s Reference Manual are not covered by the Biosystems standard 
warranty. 
The obligation of Biosystems under this warranty is limited to the repair or replacement of components 
deemed by the Biosystems Instrument Service Department to have been defective under the scope of 
this standard warranty.  To receive consideration for warranty repair or replacement procedures, 
products must be returned with transportation and shipping charges prepaid to Biosystems at its 
manufacturing location in Middletown, Connecticut, or to a Biosystems Authorized Warranty Service 
Center.  It is necessary to obtain a return authorization number from Biosystems prior to shipment. 
THIS WARRANTY IS EXPRESSLY IN LIEU OF ANY AND ALL OTHER WARRANTIES AND 
REPRESENTATIONS, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, THE 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE. BIOSYSTEMS WILL NOT BE LIABLE 
FOR LOSS OR DAMAGE OF ANY KIND CONNECTED TO THE USE OF ITS PRODUCTS OR 
FAILURE OF ITS PRODUCTS TO FUNCTION OR OPERATE PROPERLY. 

Instrument & Accessory Warranty Periods 
Product(s) Warranty Period 
PhD5, PhD Lite, PhD Plus, PhD Ultra, Cannonball3, MultiVision, 
Toxi, Toxi/Oxy Plus, Toxi/Oxy Ultra, ToxiVision, Ex Chek As long as the instrument is in service 

ToxiPro®, MultiPro 2 years from date of purchase 

ToxiLtd® 
2 years after activation or 2 years after 
the “Must Be Activated By” date, 
whichever comes first 

Toxi3Ltd® 
3 years after activation or 3 years after 
the “Must Be Activated By” date, 
whichever comes first 

Mighty-Tox 
90 days after activation or 90 days after 
the “Must Be Activated By” date, 
whichever comes first 

Mighty-Tox 2 
Prorated credit is given towards repair or purchase of a new unit of 
the same type.  

 0 – 6 months of use  100% credit 
 6 – 12 months of use  75% credit 
 12 – 18 months of use  50% credit 
 18 – 24 months of use  25% credit 

IQ Systems, Series 3000, Airpanel, Travelpanel, ZoneGuard, 
Gas Chek1 and Gas Chek4 One year from the date of purchase 

Battery packs and chargers, sampling pumps and other 
components, which by their design are consumed or depleted during 
normal operation, or which may require periodic replacement 

One year from the date of purchase 

Sensor Warranty Periods 
Instrument(s) Sensor Type(s) Warranty Period 

O2, LEL**, CO, CO+, H2S & 
Duo-Tox 2 Years PhD Plus, PhD Ultra, PhD5, PhD Lite, 

Cannonball3, MultiVision, MultiPro, ToxiVision, 
ToxiPro®, Ex Chek All Other Sensors 1 Year 

CO, CO+, H2S 2 Years 
Toxi, Toxi/Oxy Plus, Toxi/Oxy Ultra 

All Other Sensors 1 Year 
All Others All Sensors 1 Year 

**  Damage to combustible gas sensors by acute or chronic exposure to known sensor poisons such 
as volatile lead (aviation gasoline additive), hydride gases such as phosphine, and volatile silicone 
gases emitted from silicone caulks/sealants, silicone rubber molded products, laboratory glassware 
greases, spray lubricants, heat transfer fluids, waxes & polishing compounds (neat or spray aerosols), 
mold release agents for plastics injection molding operations, waterproofing formulations, vinyl & 
leather preservatives, and hand lotions which may contain ingredients listed as cyclomethicone, 
dimethicone and polymethicone (at the discretion of Biosystems Instrument Service department) void 
Biosystems’ Standard Warranty as it applies to the replacement of combustible gas sensors. 


